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ASCENDER - Position Management: Setup
and Processing for Existing Users

This guide provides existing users with the necessary steps to begin the next year (forecasting)
process in the Position Management application.

This guide assumes you are familiar with the basic features of the ASCENDER Business system and
have reviewed the ASCENDER Business Overview guide.

Set up Next Year Tables

Export next year PMIS.1.

Position Management > Utilities > Export PMIS Tables

This utility is used to export current and next year position management tables for all pay
frequencies including PMIS District Options. The export includes active/inactive positions and
supplemental positions.

You can use the Position Management > Utilities > Import PMIS Tables page to import the
tables.

Note: If data is changed after the export and then imported, those changes are not included.

Export position management tables:

Field Description
Export File Name This field is preset and display only. The export file name has the format

dbcccddd_PMIS_mmddyyyy.rsf, where cccddd is the county-district
number, PMIS indicates position management, and mmddyyyy is the
current date.

https://help.ascendertx.com/test/business/doku.php/business_overview_guide
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/exportpmistables
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/importpmistables
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_existingusers_exportpmistables.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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Field Description
Enter the Password
to be used for the
Archive

Type a password for the exported file.

❏ Click Execute. The tables are exported and a message is displayed indicating that the export
process was completed successfully.

Clear next year payroll tables and copy all tables from current to next year.2.

Log on to the current year pay frequency.

CAUTION: Before moving forward, keep in mind that this step clears all manual
changes that were made to next year salary tables.

Perform the following two processes:

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

This tab is used to clear:

All next year tables for all pay frequencies regardless of the pay frequency to which
you are logged on.
Only EOY accrual data.
Only next year payroll budget data.

Individual frequencies cannot be selected for deletion.

Note: EOY accrual reversals must be created and interfaced to Finance before clearing next
year tables or EOY accrual data only.



Business

2026/07/10 11:20 3 ASCENDER - Position Management: Setup and Processing for Existing Users

Clear next year tables:

Field Description
Clear EOY Accrual Data
Only

Select to clear the EOY accrual data records only. All other next
year data is left intact.

Clear NY Payroll Budget
Only

Select to clear the next year payroll budget records only. All other
next year data is left intact.

Note: If an option is not selected, all displayed next year tables for all pay frequencies
(regardless of the pay frequency to which you are logged on) are cleared when you click
Execute.

All available next year payroll tables are displayed on the left side of the page. Select the tables
to clear. Use the arrow buttons to move the selected tables from the left side to the right side of
the page.

❏ Click Execute. A message is displayed indicating that the next year records have been
cleared. Click OK.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_existingusers_clearcyrtablestonyr.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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This tab is used to copy all tables or selected tables as next year records for the
corresponding next year frequency (e.g., CYR = 6, NYR = F; CYR = 5, NYR = E; and CYR = 4,
NYR = D). The tables are copied from all current year frequencies to all next year frequencies
(except the School Calendar table). The School Calendar table header is only copied for the
frequency to which you are logged on. To copy the school calendar for another frequency, log
on to the other frequency and copy the School Calendar table. The calendar itself is not
copied, only the calendar code and calendar description. Type the year in the Start Year
field and the beginning month in the Start Month field to begin the process of building the
next year calendar.

Copy current year tables:

All available current year tables are displayed on the left side of the page. Select the tables to
copy. Select the corresponding check boxes to select a table. At least one table option must be
selected.

Select ❏ next to the table(s) to copy.
Select ❏ again to clear the selected check box.

❏ Click  if you do not want to copy the entire table, but want to include specific data from a
table.

Notes:

Only the selected tables are processed.
If the tables are copied multiple times and the record in the current year does not
exist in the next year, the new record is inserted in the next year.
If the tables are copied multiple times and a description is changed in the next year
but not in the current year, the description is replaced by the description in the
current year table.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_copycyrtablestonyr.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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❏ Click Select All Tables to select all current year tables to copy to the next year.

❏ Click Execute. A separate preview report is displayed for each selected table.

❏ Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

Copy current year staff to the next year payroll.3.

Log on to the current year pay frequency.

Payroll > Next Year > Copy CYR Staff to NYR

Complete the following:

❏ In the Pay Type field, select E - Exclude Substitute.

❏ Under Options:

Select Include Employees with Termination Date.
In the Next Year’s Funding Code, type the fiscal year that exists in Budget.

❏ Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

❏ Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that
were copied is displayed. Click OK.

❏ Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/copycyrstafftonyr
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_copycyrstafftonyr.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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Update next year payroll tables.4.

Update the following tables as needed:

❏ Salaries

Personnel > Tables > Salaries NYR > Local Annual - Only contracted employees
Personnel > Tables > Salaries NYR > Hourly/Daily - All contracted, noncontracted, and
hourly employees
Personnel > Tables > Salaries NYR > Extra Duty
Personnel > Tables > Salaries NYR > State Minimum
Personnel > Tables > Salaries NYR > Midpoint

Log on to the next year pay frequency.

❏ Tax/Deductions - Verify that you are logged on to the next school or calendar year (2024).
The current and next year tables are shared. Any current year changes affect the current year
payroll. These fields are updated when calculating employee taxes and benefits for budget
purposes; therefore, they must exist in the next school year.

Payroll > Tables > Tax/Deductions > FICA Tax
Payroll > Tables > Tax/Deductions > Unemployment
Payroll > Tables > Tax/Deductions > TRS Rates
(If applicable) Payroll > Tables > Salaries > Workers’ Comp

❏ Job/Contract - Add or update job codes as needed. If any job codes are added or updated,
indicate the accrual code and workers' compensation code if applicable.

Personnel > Tables > Job/Contract NYR > Job Codes

❏ Calendars - This step must be completed prior to continuing to the next step.

Personnel > Tables > Workday Calendars > School Calendar – All employees must have a
school calendar.

Set up next school year pay dates.5.

Log on to the current year pay frequency.

Payroll > Tables > Pay Dates

https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/localannual
https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/hourlydaily
https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/extraduty
https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/stateminimum
https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/midpoint
https://help.ascendertx.com/test/business/doku.php/payroll/tables/taxdeductions/ficatax
https://help.ascendertx.com/test/business/doku.php/payroll/tables/taxdeductions/unemployment
https://help.ascendertx.com/test/business/doku.php/payroll/tables/taxdeductions/trsrates
https://help.ascendertx.com/test/business/doku.php/payroll/tables/taxdeductions/workerscomp
https://help.ascendertx.com/test/business/doku.php/personnel/tables/jobcontract/jobcodes
https://help.ascendertx.com/test/business/doku.php/personnel/tables/workdaycalendars/schoolcalendar
https://help.ascendertx.com/test/business/doku.php/payroll/tables/paydates
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Although the current year pay dates are used at this time, the next year pay dates can be
created. The next year pay dates must be set up prior to rolling positions to the next year PMIS.

Set up District Administration Options

Update Position Management options.1.

District Administration > Options > Position Management

This page is used to create and maintain Position Management options including the types of
calculations that should be used in Position Management and the specified default values to
be used for certain types of Position Management transactions. These options are not

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_paydates_table.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/districtadmin/doku.php/options/positionmanagement
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typically changed throughout the school year.

❏ Verify that the following fields are completed and accurate:

Current Year
Next Year
Minimum Foundation Year - Type the four-digit current or next school year in the YYYY
format to allow the system to select the corresponding tables to calculate the state
minimum salary amount. If this year matches the current year value, the current
Personnel state minimum table is used. If this year matches the next year value, the next
year Personnel state minimum table is used.

Update the current and next year first pay date codes.2.

Use the following pages to establish the current and next year first pay dates and codes.

District Administration > Tables > PMIS > First Pay Date > Current Year

This tab is used to create and maintain a list of codes associated with current year pay dates
to be used for Position Management. The codes are used:

To establish an association between a table ID and a starting pay date.
To establish a start date for a new teacher so that a new teacher can be paid over 13
months.
To determine the first pay date of the new school year when calculating the amounts
already paid to an employee.
To calculate the amount to be paid to an employee during the change-in-compensation
processing.
To update the payroll data with the data in the forecast records, and to move the

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_districtadmin_pmisoptions.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/districtadmin/doku.php/tables/pmis/firstpaydate/currentyear


Business

2026/07/10 11:20 9 ASCENDER - Position Management: Setup and Processing for Existing Users

forecast data into the current position records.

In this example, the first pay date codes begin with J, A, or S to represent the first pay date
month (July, August, or September). The subsequent two characters represent the calendar
code. Codes can be a maximum of three characters and any letters should be uppercase.

Complete the Current Year and Next Year tabs. The Current Year tab represents the first pay
dates for the current school year, and the Next Year tab represents the first pay dates for the
next school year.

District Administration > Tables > PMIS > First Pay Date > Next Year

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_districtadmin_firstpaydate_cyr.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/districtadmin/doku.php/tables/pmis/firstpaydate/nextyear
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Update the forecast conversion data.3.

Prior to completing this step, the calendars and pay dates must exist in the next
year payroll files.

District Administration > Tables > PMIS > Forecast Conversion

This page is used to create forecast data for the next year's records. This table maintains the
data conversion information by the First Pay Date Code for the Calendar Code, Begin
Date, End Date, Payoff Date, Max Days, Number Of Days Off and Actual Payments.
These fields should be updated with the dates to be used for the next school year. From this
data, the appropriate calendar data is located and the following calculation is performed: The
Local Begin Date is subtracted from the Local End Date, and then the Number of Days
Off is subtracted resulting in the number of Actual Days.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/next_year_first_pay_date_table.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/districtadmin/doku.php/tables/pmis/forecastconversion
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For each pay date code, complete the fields on the page. The next year begin and end dates
must match the new calendars in the next year payroll files, and the payoff dates must exist in
the pay dates table for each first pay date code.

This process updates the table and replaces the mass updating process that is done in the next
year payroll.

The Days Off field is used to reduce the days worked without tying back to unavailable days on
a calendar. For example, a district police officer may work every day (or have the potential to
work every day) but may have a certain number of days off per year that can be taken at any
time.

Reminder: If you set up a new calendar code in Position Management at any point
during the year, be sure to set up a new first pay date code using that calendar
code and add that information to this table.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_existingusers_districtadmin_forecastconversion.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers


Business

2026/07/10 11:20 12 ASCENDER - Position Management: Setup and Processing for Existing Users

Perform Position Management Maintenance

Log on to the next year.

Delete next year PMIS.1.

Position Management > Utilities > Mass Delete Forecast Positions

❏ Leave all fields blank and click Execute. A list of processing reports is displayed.

❏ Select the reports to generate, and print or save the reports.

❏ Click Process to delete the forecast records. You are prompted to create a backup.

https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/massdeleteforecastpositions
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_massdeleteforecastpositions.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_massdeleteforecastpositionsb.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/general/pmis_backup
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Copy current year positions to the next year.2.

Position Management > Utilities > Create Forecast Positions

If an LEA has the Percent of Year field set to less than 100% of the stipend
amount on the Position Management > Maintenance > PMIS Supplement Modify >
Position Record tab, they should consider whether or not to select the Reset
Supplement Amounts based on Extra Duty Code Table Default Amount
field.

If the Reset Supplement Amounts based on Extra Duty Code Table Default
Amount field is selected, the amount on the supplement position record is reset to
match the amount on the extra duty table.

❏ Select all fields and click Execute. A list of processing reports is displayed.

❏ Select the reports to generate and print or save the reports. Verify any errors and make
corrections as needed.

❏ Click Process. You are prompted to create a backup.

https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/createforecastpositions
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_createforecastpositions.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmissupplementmodify/positionrecord
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmissupplementmodify/positionrecord
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_createforecastpositionsb.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/general/pmis_backup
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Update the fiscal year for distributions.3.

Prior to completing this step, verify that the new year budget is initialized in ASCENDER.

Position Management > Utilities > Update Fiscal Year by Fund

❏ Select the fund/years to be incremented. This process increments the position distribution
fiscal year by 1.

❏ Click Execute.

Generate the Position Listing by Campus Report.4.

Position Management > Reports > PMIS Reports > HRS8050 - Position Listing by Campus

Generate the Position Listing by Campus Report from next year Position Management to
determine the following:

If any employees need to be moved to a different position.
If you have vacant positions you need to update with employee information.
If you have any supplemental positions that need to be updated for stipends.

https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/updatefiscalyearbyfund
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_updatefiscalyearbyfund.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/reports/pmisreports/positionlistingbycampus
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(If necessary) Transfer positions from one first pay date code to another.5.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date
code when a new hire employee on a 13-month pay date cycle needs to convert to a regular
12-month pay date cycle.

(If necessary) Update regular and supplemental positions.6.

Note: If your LEA comes across a situation where teachers are not being captured in the
ASCENDER Student system for grade reporting or scheduling, contact your regional ESC
consultant for guidance.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_hrs8050positionlistingbycampusb.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/districtadmin/doku.php/tables/pmis/firstpaydateforecastconversion
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_districtadmin_firstpaydateconversion.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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Position Management > Maintenance > PMIS Position Modify or PMIS Supplement Modify

If working on the Distribution tab, you must select an account code from the
autosuggest drop down in the Account Code field versus typing in the full
account code in order to validate against the grant code table.

If necessary, use one of the following options to vacate an employee from a position:

❏ Option 1: It is best practice to use the Position Management > Utilities > Vacate Employee
from Forecast Positions page to vacate a position.

Typically, when an employee decides to leave the LEA at the end of the year, the employee is
paid off in payroll at the end of their contract; therefore, no additional action is necessary for
the current year. However, in the forecast records, the employee must be removed from all
existing positions.

https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmispositionmodify/positionrecord
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmissupplementmodify/positionrecord
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_pmispositionmodify.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/vacateemployeefromforecastpositions
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/vacateemployeefromforecastpositions
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Retrieve the employee's position record.
Select the Vacate check box for each position.
Click Save.

❏ Option 2: Use the Position Management > Maintenance > PMIS Forecast Change page (only
available in the next year payroll) to change an employee from one position to another. A list of
the employee's existing positions is displayed with a section to either enter a new position or
vacate a position.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_vacatefromforecastposition.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmisforecastchange
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_pmisforecastchange.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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Generate the PMIS/Payroll Discrepancy Report.7.

Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll Discrepancy Report

Generate the PMIS/Payroll Discrepancy report to determine if there are any active employees
not assigned to a forecast position. Below are some examples of the PMIS/Payroll Discrepancy
report:

Generate a user-created report.8.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last
year.

❏ It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

❏ Select the following fields on the user-created report:

https://help.ascendertx.com/test/business/doku.php/positionmanagement/reports/pmisreports/pmispayrolldiscrepancyreport
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_hrs8054pmispayrolldiscreport3.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_hrs8054pmispayrolldiscreport2.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/reports/usercreatedreports/cyrnyrpositions
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❏ Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

Update position records.9.

Position Management > Maintenance > PMIS Position Modify > Position Record

If necessary, update the Increase Eligible field to identify the employees who are eligible to
receive a salary increase for the new school year when running simulations. Only the employees
with this field selected will receive a salary increase.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_usercreatedreport.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmispositionmodify/positionrecord
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❏ Clear the Increase Eligible field for new employees who are not entitled to a salary
increase. Remember that the next year Position Management pay step reflects the same
current year Position Management pay step, and the step is increased in the salary simulations
if the Increase Eligible field is selected.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_updatepositionrecord.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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❏ If necessary, update the New Employee field to identify new employees on forecast position
records. If selected, the salary simulations will budget the employer contribution for new
employees even though they do not have current year payroll records.

Notes:

This field is not displayed on supplemental position records.

If the position is changed to any status other than Active, the field is disabled.

❏ Clear this field If an employee is no longer new to the LEA.

Position Management > Maintenance > PMIS Position Modify > Budget

If there are retirees who work in the LEA, confirm that the TRS Status field is set to 5 - Retired.
If the TRS status is incorrect, there is a possibility that the status will be incorrect (TRS-eligible)
when the employee is moved to the current year payroll.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_updatepositionrecordnewemployee.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmispositionmodify/positionrecord
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https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_budget_retired.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingforexistingusers
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